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PREFACE
Every effort has been made to ensure that the information in this document 
is complete, accurate, and up-to-date. The manufacturer assumes no 
responsibility for the results of errors beyond its control. The manufacturer 
also cannot guarantee that changes in software and equipment made by 
other manufacturers and referred to in this guide will not affect the 
applicability of the information in it. Mention of software products 
manufactured by other companies does not necessarily constitute 
endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as 
accurate and helpful as possible, we make no warranty of any kind, expressed 
or implied, as to the accuracy or completeness of the information contained 
herein.

The most up-to-date drivers and manuals are available from the Oki Printing 
Solutions website:

www.okiprintingsolutions.com

Copyright © 2007. All rights reserved.

Oki and Microline are registered trademarks of Oki Electric Industry 
Company, Ltd.

Hewlett-Packard, HP, and LaserJet are registered trademarks of Hewlett-
Packard Company.

Microsoft, MS-DOS and Windows are registered trademarks of Microsoft 
Corporation.

ENERGY STAR is a trademark of the United States Environmental Protection 
Agency.

Apple, Macintosh, Mac and Mac OS are registered trademarks of Apple 
Computer.

Other product names and brand names are registered trademarks or 
trademarks of their proprietors.

As an ENERGY STAR Program Participant, the manufacturer 
has determined that this product meets the ENERGY STAR 
guidlines for energy efficiency.

This product complies with the requirements of the Council 
Directives 89/336/EEC (EMC) and 73/23/EEC (LVD) as 
amended where applicable on the approximation of the laws 
of the member states relating to electromagnetic 
compatibility and low voltage.

B4400, B4600 – ✘ B4400L, B4600L – ✔ 

NOTE
The PostScript Emulation feature described in this guide is 
only available in some countries.
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EMERGENCY FIRST AID

Take care with toner powder:

If swallowed, induce vomiting and seek medical 
attention. Never attempt to induce vomiting if person is 
unconscious.

If inhaled, move the person to an open area for fresh air. 
Seek medical attention.

If it gets into the eyes, flush with large amounts of water 
for at least 15 minutes keeping eyelids open. Seek 
medical attention.

Spillages should be treated with cold water and soap to 
help reduce risk of staining skin or clothing.

IMPORTER TO THE EU
Oki Europe Limited (trading as OKI Printing Solutions)
Central House
Balfour Road
Hounslow
TW3 1HY
United Kingdom

For all sales, support and general enquiries contact your local 
distributor.

ENVIRONMENTAL INFORMATION
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NOTES, CAUTIONS AND WARNINGS

NOTE
A note appears in this manual like this. A note provides 
additional information to supplement the main text which 
may help you to use and understand the product.

CAUTION!

A caution appears in this manual like this. A caution 
provides additional information which, if ignored, may 
result in equipment malfunction or damage.

WARNING!

A warning appears in this manual like this. A warning 
provides additional information which, if ignored, may 
result in a risk of personal injury.
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INTRODUCTION
Congratulations on purchasing this 24/26 pages per minute 
monochrome page printer. 

Your new printer is designed with a range of advanced features 
to give you crisp black and white pages at high speed on a wide 
range of print media.

For your information, a summary of the main features of your 
printer is given below.

PRINTER FEATURES

> 12 different models to choose from: B4400, B4400L, 
B4400n, B4400Ln, B4600, B4600L, B4600n, B4600Ln 
(n denotes Network Interface Card included), B4600PS, 
B4600LPS (PostScript PS Level 3 emulation DIMM 
included) and B4600nPS, B4600LnPS (nPS denotes 
Network Interface Card and PostScript PS Level 3 
emulation DIMM included)

> Memory:  32MB

> High speed printing:  24/26 pages per minute

> Resolution: 1200 x 600 dpi

> Paper handling: 250 sheets (80g/m²).

> Emulation: Printer Control Language PCL5e, Epson FX, 
IBM ProPrinter

> Barcodes: embedded for SIDM emulations

> 8MB Flash DIMM: to allow the storage of additional fonts 
or bar codes

> USB 2.0 and Parallel interfaces

> “Ask Oki” – a user-friendly function that gives a direct link 
from your printer driver screen (but not illustrated in this 
guide) to a dedicated web site specific to the exact model 
you are using. This is where you’ll find all the advice, 
assistance and support you could need to help you get the 
best possible results from your Oki printer.
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Additionally, the following optional features are also available:

> 10/100 BASE-TX Network Interface Card: to make the 
B4400, B4400L and B4600, B4600L network compatible

> 16, 32, 64, 128, 256MB RAM DIMM: to extend the main 
memory of your printer and speed up the processing of 
large files

> RS232C Card: to provide serial interface capability for the 
B4400, B4400L and B4600, B4600L

> Second paper tray: to increase your printer’s paper 
handling capacity by 500 sheets (80g/m²)

> Multi-purpose tray: to extend the range of media your 
printer can accommodate (capacity 100 sheets (80g/m²) 
or 50 envelopes)

> One of the following can be added:

> 8MB Flash DIMM: to allow the storage of additional 
fonts or bar codes for the B4400, B4400L, B4400n, 
B4400Ln, B4600, B4600L, B4600n, B4600Ln

> 16MB Flash DIMM: to allow the storage of additional 
fonts or bar codes for the B4400, B4400L, B4400n, 
B4400Ln, B4600, B4600L, B4600n, B4600Ln

> PostScript PS level 3 DIMM: to add PostScript 
emulation to the B4600, B4600L or B4600n, B4600Ln. 
Cannot be added in conjunction with extra flash 
memory. (See the section entitled “Installing Options” 
for full details.)

USING YOUR PRINTER

To help you get the most from your printer, the manufacturer has 
provided a variety of supporting materials. A summary of these 
materials and their purposes is given in the following chapter. 
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ABOUT THIS MANUAL
This manual is the user’s guide (check the Oki Printing Solutions 
website, www.okiprintingsolutions.com, for the most up-to-date 
version) for your printer and forms part of the overall user 
support listed below:

> Quick Set-up Guide: to describe how to unpack, connect 
and power up your printer.

> This User’s Guide: to help you to operate your printer 
and make the best use of its many features. Also included 
are guidelines for troubleshooting and maintenance to 
ensure that it performs at its best. Additionally, 
information is provided for adding optional accessories as 
your printing needs evolve.

> Installation Guides: accompany consumable items and 
optional accessories to describe how to install them.

> Online Help: online information associated with the 
printer driver and Status Monitor software.

This manual has been written using more than one printer as a 
model and the illustrations/screenshots reflect this. What you see 
will be appropriate to the model you are using.

ONLINE USAGE

This manual is intended to be read on screen using an Adobe 
Acrobat Reader. Use the navigation and viewing tools provided in 
Acrobat.

You can access specific information in two ways:

> In the list of bookmarks down the left hand side of your 
screen, click on the topic of interest to jump to the 
required topic. (If the bookmarks are not available, use 
the Table of Contents.)

> In the list of bookmarks click on Index to jump to the 
Index. (If the bookmarks are not available, use the Table 
of Contents.) Find the term of interest in the 
alphabetically arranged index and click on the associated 
page number to jump to the page containing the subject.
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PRINTING PAGES

The whole manual, Individual pages, or sections may be printed. 
The procedure is:

1. From the toolbar, select File > Print (or press the 
Ctrl + P keys).

2. Choose which pages you wish to print:

(a) [All pages], for the entire manual.

(b) [Current page] for the page at which you are 
looking.

(c) [Pages from] and [to] for the range of pages you 
specify by entering their page numbers.

3. Click on OK.
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ABBREVIATIONS USED

The following abbreviations are used in this manual:

ABBREVIATION MEANING

Ctrl Control

dpi dots per inch

DIMM Dual In-line Memory Module

n network card installed

LED Light Emitting Diode

NIC Network Interface Card

PCL Printer Control Language

PS PostScript (emulation)

PSE PostScript Emulation

RAM Random Access Memory

SIDM Serial Impact Dot Matrix
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PRINTER COMPONENTS
Apart from the Operator panels, which are described in the next 
chapter, the B4400, B4400L, B4400n, B4400Ln, B4600, B4600L, 
B4600n, B4600Ln, B4600PS, B4600LPS and B4600nPS, 
B4600LnPS printers look similar from the outside. The important 
components are identified in the representations below.

1. Operator panel (B4400 shown)

2. Output Stacker (150 sheets, face down)

3. Top cover release button

4. Output Stacker extension

5. Output Stacker extension paper guide 

6. Paper Tray content indicator

7. ON/OFF switch

8. Rear Output Stacker (50 sheets, face up)

9. Rear Output Stacker paper guide 

1

2
3

4

5

6

7

8

9

B4400, B4400L/B4600, B4600L User’s Guide – Printer components > 13



10. LED array

11. Image drum

12. Manual Feed Tray (single sheet) (shown in closed position)

13. Paper Tray (250 sheets)

14. Toner cartridge

15. Fuser unit

16. Top cover

16

15

14 13

12

11

10
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17. Power cable connection

18. Cooling fan

19. USB interface connection

20. Parallel interface connection

21. Second paper tray (optional) connection

22. Network card (standard on B4400n, B4400Ln, B4600n, 
B4600Ln, B4600nPS, B4600LnPS and optional on B4400, 
B4400L, B4600, B4600L, and B4600PS, B4600LPS)

23. RS232 serial interface card (optional on B4400, B4400L, 
B4600, B4600L and B4600PS, B4600LPS)

24. Optional Multi Purpose Tray connection 

24
23

18

192021

22

17
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OPERATOR PANELS
This chapter describes the function of the operator panel on your 
printer. It is useful to describe the Status Monitor software at this 
point as it provides the B4400, B4400L, B4400n, B4400Ln status 
information and the equivalent of the menu control panel on the 
B4600, B4600L, B4600n, B4600Ln, B4600PS, B4600LPS, 
B4600nPS, B4600LnPS. (See “Printer Drivers” for installation of 
the Status Monitor.)

B4400, B4400L, B4400N, B4400LN

OPERATOR PANEL

The B4400, B4400L, B4400n, B4400Ln operator panel consists of 
4 indicating LEDs and an Online button. From left to right, the 
LEDs indicate Power On, Ready, Manual feed and Error.

LED INDICATORS

The LED indicators show the status of the printer and have five 
operating conditions as follows:

> Indicator off

> Indicator on

> Flash 1 - slow blink - 1 long flash every 4 seconds

> Flash 2 - blink - 1 flash per second

> Flash 3 - rapid blink - 4 flashes per second.

All four LED indicators come on momentarily when power is 
switched on using the main power switch.
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Power on LED (green)

This indicator comes on and stays on when the printer is switched 
on using the main power switch.

Ready LED (green)

> Indicator on - the printer is on-line and ready to receive 
data.

> Indicator off - the printer is off-line and cannot receive 
data.

The meaning of the indicator LEDs when they flash (x) is 
summarised as follows:

FLASH 
TYPE

READY 
LED
(GREEN)

MANUAL 
FEED LED
(AMBER)

ERROR 
LED
(AMBER)

MEANING

Flash 1 –

slow 
blink

x The printer is data 
processing when 
printing has been 
suspended. 

x The image drum 
requires changing, 
toner is low or paper 
tray is empty but no 
job is processing.
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ONLINE BUTTON

The primary functions of the Online button are activated by 
pressing the switch momentarily and releasing. The primary 
functions are as follows:

> Turning the printer off-line.

> Turning the printer on-line (ready).

> Resuming printing after a print overrun, page overflow, or 
receiving buffer overflow.

> Interrupting data processing when the printer is receiving 
and processing data.

Flash 2 
—

blink

x The printer is 
receiving and 
processing data 
during printing or 
the printer is 
resetting.

x The printer is 
requesting that a 
Manual Feed Tray is 
used for paper feed. 

x There is a printing 
error, for example, a 
problem with paper, 
the cover is open or 
the paper tray is 
empty while a job is 
processing.

x x x There is a minor 
error with the 
printer, for example, 
toner is low and the 
image drum needs 
to be changed.

Flash 3 
—

rapid 
blink

x x x There is a major 
error with the 
printer, requiring a 
service call, for 
example, a 
hardware problem.

FLASH 
TYPE

READY 
LED
(GREEN)

MANUAL 
FEED LED
(AMBER)

ERROR 
LED
(AMBER)

MEANING
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> Resuming data processing.

The secondary functions of the Online button are activated after 
turning the printer off line, then pressing and holding the switch 
for four seconds before releasing. The secondary functions are as 
follows:

> Printing the demo and menu pages.

> Printing any data held in the buffer after printing has been 
cancelled.

The other functions of the Online button are activated after 
turning the printer off line then pressing and holding the switch 
for seven seconds before releasing. The other functions are as 
follows:

> Printing a cleaning page.

> Resetting the printer and clearing the buffer after printing 
has been cancelled.

NOTE
Demo and menu pages can also be printed using the printer 
Status Monitor.

NOTE
A cleaning page can also be printed using the printer Status 
Monitor.

NOTE
To reset the printer to the default settings of the 
manufacturer, the Online button is pressed and held down 
while the printer is switched on with the main power switch. 
The LED indicators blink when the printer has reset to the 
default settings.
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STATUS MONITOR

After installing the printer driver software onto your computer, 
the Status Monitor is then installed to indicate what is happening 
to the printer when it is being used. (See the chapter entitled 
“Printer Drivers”.) This Status Monitor is also used to control and 
change the various printer settings.

Using the Printer Status Monitor

Viewing the status of the printer, and viewing or changing the 
printer settings are carried out as follows:

Click on Start > All Programs > Okidata > Status Monitor and 
select the Status Monitor. The current printer status is shown.
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Printer Setup Tab

Selecting the Printer Setup tab provides access to the Printer 
Menu button, which, when selected, enables you to:

> Select which printer to connect to via the Select Printer 
button.

> Configure the printer settings via the Open 
Configuration button. 

At all stages, detailed on-line help is provided via the Help 
button.
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Preferences Tab 

Selecting this tab provides the means to choose the information 
displayed by the Status Monitor and how/when the Status 
Monitor appears.

The default Alert view setting ensures that the Status Monitor 
pops up to inform you of a condition that requires your attention 
e.g. toner low.
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MENU FUNCTIONS

The Printer Menu allows you to view and change the printer’s 
internal settings. You can think of this as the software equivalent 
of an LCD operator panel display that appears on the front of 
some printers.

The settings are grouped into categories or “menus” such as 
Information Menu or Print Menu.

Some of these settings are similar to those found in your printer 
driver or application software. The settings that you can change 
using this software act as the printer’s defaults. These can be 
overridden by the settings in your printer driver or application.

For example, if you have set the number of copies in the Printer 
Menu settings to one, this will be overridden if you select three 
copies of your document in the printer driver.
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Information Menu

This menu provides a quick method of listing various items stored 
within the printer.

Print menu

This menu provides adjustment of various print job related 
functions.

INFORMATION MENU

ITEM ACTION

PRINT MENU MAP Apply

PRINT FILE LIST Apply

PRINT PCL FONT Apply

PRINT PSE FONT Apply When PSE is installed

PRINT IBM PPR FONT Apply

PRINT EPSON FX FONT Apply

PRINT DEMO 1 Apply

PRINT MENU

ITEM DEFAULT REMARKS

COPIES 1

MANUAL FEED MODE OFF

PAPER SOURCE TRAY1

AUTO TRAY CHANGE OFF

ON

No optional tray installed

When Tray2 or MPF is 
installed

AUTO TRAY SEQUENCE DOWN

PAPER SIZE CHECK ENABLE

RESOLUTION 600

TONER SAVE DISABLE

ORIENTATION PORTRT

LINES PER PAGE 64LNS

EDIT SIZE CASSETT
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Media Menu

This menu provides adjustment to suit a wide range of print 
media.

System configuration menu

This menu adjusts general printer settings to suit the way you 
prefer to work.

MEDIA MENU

ITEM DEFAULT REMARKS

TRAY1 MEDIA SIZE A4 SIZE

TRAY1 MEDIATYPE PLAIN

TRAY1 MEDIAWEIGHT MEDIUM

TRAY2 PAPERSIZE A4 SIZE When tray 2 is installed

TRAY2 MEDIATYPE PLAIN When tray 2 is installed

TRAY2 MEDIAWEIGHT MEDIUM When tray 2 is installed

MPF MEDIA SIZE DL ENV When MPF is installed

MPF MEDIATYPE PLAIN When MPF is installed

MPF MEDIAWEIGHT MEDIUM When MPF is installed

MANUAL TRAY MEDIA SIZE A4 SIZE

MANUAL TRAY MEDIA TYPE PLAIN

MANUAL TRAY MEDIA WEIGHT MEDIUM

CUSTOM PAPER SIZE UNIT mm

CUSTOM PAPER WIDTH 210 mm

CUSTOM PAPER LENGTH 297 mm

SYSTEM CONFIGURATION MENU

ITEM DEFAULT REMARKS

POWER SAVE 10 MIN

EMULATION AUTO

PARA PORT ASCII

USB PORT RAW

NW PORT RAW When NIC is installed

RS PORT ASCII When RS232 is installed

CLEAR ALARMS ON

CLEAR ERRORS ON

MANUAL FEED TIMEOUT 60 SEC

WAIT TIMEOUT 40 SEC

PRINT CONFIGURATION AT 
TONER LOW

CONT

JAM RECOVERY ON

ERROR REPORT OFF
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PCL emulation

This menu controls the printer’s PCL emulation.

PPR Emulation

This menu controls the printer’s PPR emulation.

STATUS DISPLAY LANGUAGE ENGLISH

PCL MENU

ITEM DEFAULT REMARKS

FONT SOURCE RESDENT

FONT No. I000

FONT PITCH 10.00

FONT SIZE 12.00 Not displayed in default 
setup

SYMBOL SET PC-8

A4 WIDTH 78 COL

WHITE PAGE SKIP OFF

CR FUNCTION CR

LF FUNCTION LF

UNPRINTABLE AREA NORMAL

PEN ADJUST ON

PPR MENU

ITEM DEFAULT REMARKS

FONT PITCH 10 CPI

FONT PITCH IN CONDENSE 
MODE

12 to 20

CHARACTER SET SET-2

SYMBOL SET IBM-437

LETTER O STYLE DISABLE

ZERO CHARACTER NORMAL

LINE PITCH 6 LPI

WHITE PAGE SKIP OFF

CR FUNCTION CR

LF FUNCTION LF

LINE LENGTH 80 COL

FORM LENGTH A4

TOF POSITION 0.0 INCH

SYSTEM CONFIGURATION MENU

ITEM DEFAULT REMARKS
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FX Emulation

This menu controls the printer’s FX emulation.

Parallel menu

This menu controls the operation of the printer’s parallel data 
interface.

LEFT MARGIN 0.0 INCH

FIT TO LETTER DISABLE

TEXT HEIGHT SAME

FX MENU

ITEM DEFAULT REMARKS

FONT PITCH 10 CPI

CHARACTER SET SET-2

SYMBOL SET IBM-437

LETTER O STYLE DISABLE

ZERO CHARACTER NORMAL

LINE PITCH 6 LPI

WHITE PAGE SKIP OFF

CR FUNCTION CR

LINE LENGTH 80 COL

FORM LENGTH A4

TOF POSITION 0.0 INCH

LEFT MARGIN 0.0 INCH

FIT TO LETTER DISABLE

TEXT HEIGHT SAME

PARALLEL PORT MENU

ITEM DEFAULT REMARKS

PARALLEL PORT ENABLE

BI-DIRECTIONAL ENABLE

ECP MODE ENABLE

ACK WIDTH NARROW

BUSY/ACK OUTPUT SEQUENCE IN

I-PRIME DISABLE

OFF REC DISABLE Only when PSE is 
installed

PPR MENU

ITEM DEFAULT REMARKS
B4400, B4400L/B4600, B4600L User’s Guide – Operator panels > 27



RS232C menu

This menu controls the operation of the printer’s RS232C data 
interface.

USB menu

This menu controls the operation of the printer’s USB data 
interface.

Network menu

This menu controls the operation of the printer’s 10Base-T/
100Base-TX network interface.

RS232C MENU

ITEM DEFAULT REMARKS

RS232C ENABLE Only when RS232C is 
installed

FLOW CONTROL DTR HI Only when RS232C is 
installed

BAUD RATE 9600 Only when RS232C is 
installed

DATA BITS 8 BITS Only when RS232C is 
installed

PARITY NONE Only when RS232C is 
installed

MIN. BUSY TIME 200mSEC Only when RS232C is 
installed

OFF REC DISABLE Only when both RS232C 
and PSE are installed

USB MENU

ITEM DEFAULT REMARKS

USB ENABLE

SOFTWARE RESET DISABLE

OFF REC DISABLE Only when PSE is 
installed

SERIAL NUMBER ENABLE

NETWORK MENU

ITEM DEFAULT REMARKS

TCP/IP ENABLE Only when NIC is installed

NETBEUI ENABLE Only when NIC is installed

NETWARE ENABLE Only when NIC is installed
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Memory menu

This menu determines how printer memory is used.

System adjustment menu

This menu provides fine adjustment of image position on the 
printed page in steps of 0.25mm.

ETHERTALK ENABLE Only when NIC is installed

FRAME TYPE AUTO Only when NIC is installed

IP ADDRESS SET AUTO Only when NIC is installed

IP ADDRESS Only when NIC is installed

SUBNET MASK Only when NIC is installed

GATEWAY ADDRESS Only when NIC is installed

INITIALIZE NIC? Only when NIC is installed

WEB/IPP ENABLE Only when NIC is installed

TELNET ENABLE Only when NIC is installed

FTP ENABLE Only when NIC is installed

SNMP ENABLE Only when NIC is installed

LAN NORMAL Only when NIC is installed

HUB LINK SETTING AUTO 
NEGOTIATE

Only when NIC is installed

MEMORY MENU

ITEM DEFAULT REMARKS

RECEIVE BUFFER SIZE AUTO

RSRC SAV OFF

SYSTEM ADJUSTMENT MENU

ITEM DEFAULT REMARKS

X ADJUST 0.00 mm

Y ADJUST 0.00 mm

TRAY ID

PLACE PAGE CENTER

NETWORK MENU

ITEM DEFAULT REMARKS
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Maintenance menu

This menu provides access to various printer maintenance 
functions.

Usage menu

This menu is for information only, and provides an indication of 
total usage of the printer and the expected life left in its 
consumable items. This is particularly useful if you do not have a 
full set of replacement consumables to hand and you need to 
know how soon you will need them.

MAINTENANCE MENU

ITEM DEFAULT REMARKS

RESET MENU

RESET DRUM COUNT

POWER SAVE MODE ENABLE

TRANSFER SETTING 0

DARKNESS 0

PRINT CLEANING PAGE

USAGE MENU

ITEM DEFAULT REMARKS

TOTAL SHEETS REMAINING The total number of 
sheets the printer has 
printed.

DRUM LIFE REMAINING% An indication of how soon 
you will need to replace 
the drum.

TONER LIFE 6K=%   
2.5K=% 

An indication of how 
much toner is left in the 
cartridge.
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PRINTING MENU SETTINGS

The menu settings can be printed as a menu map as follows.

Using the Online button

1. Press the Online button to take the printer off-line.

2. Press and hold down the Online button for at least four 
seconds, but less than seven seconds.

3. The printer prints a list of the menu settings and a demo 
print page.

Using the Status Monitor

1. Select Start > All Programs > Okidata > Status Monitor.

2. Select the Printer Setup Tab.

3. Click on the Open Configuration button. The Printer 
Menu is displayed.

4. Expand the Information Menu. 

5. To print a demo page or Menu Map, select either “Print 
Demo1” or “Print Menu Map” and click on the Apply 
button.
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B4600, B4600L, B4600N, B4600LN, B4600PS, B4600LPS, 
B4600NPS, B4600LNPS

OPERATOR PANEL

The B4600, B4600L, B4600n, B4600Ln, B4600PS, B4600LPS, 
B4600nPS, B4600LnPS operator panel consists of a menu driven 
control panel, an LCD display and a LED indicator.

PANEL ELEMENTS

Ready indicator (green). ON - ready to receive data. FLASHING 
indicates processing data or error.

1. Liquid crystal display. (LCD) panel. Two rows of up to 8 
alphanumeric digits displaying print status, menu items in 
menu mode and error messages. 

2. Menu Button. Press briefly to enter the MENU mode. 
Press briefly again to select the next menu. Press for more 
than 2 seconds to scroll through the different menus.

3. Item (+) button. Press briefly to scroll forward to the 
next menu item.

4. Value (+) button. Press briefly to scroll forward to the 
next value setting for each menu item.

5. Select button. Press briefly to select the menu, item or 
value indicated on the LCD panel.

6. Cancel button. Press to cancel a print job.

7. Value (–) button. Press briefly to scroll backward to the 
previous value setting for each menu item.

MENU

READY

ITEM VALUE SELECT

CANCEL

+ +
---

ON LINE
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8. Item (–) button. Press briefly to scroll backward to the 
previous menu item.

9. Online button. Press to switch between online and offline 
status. 

MENU FUNCTIONS

The Printer Menu allows you to view and change the printer’s 
internal settings.

The settings are grouped into categories or “menus” such as 
Information Menu or Print Menu.

Some of these settings are similar to those found in your printer 
driver or application software. The settings that you can change 
using this software act as the printer’s defaults. These can be 
overridden by the settings in your printer driver or application.

For example, if you have set the number of copies in the Printer 
Menu settings to one, this will be overridden if you select three 
copies of your document in the printer driver.

Factory default settings are shown in the following tables.

Information Menu

This menu provides a quick method of listing various items stored 
within the printer.

NOTE
When pressed in Menu mode, the Online button returns the 
printer to ONLINE status. When pressed with DATA PRESENT 
displayed, it forces the printer to print out the remaining data 
in the printer. Also when there is an error indicating wrong 
paper size, pressing the Online button forces the printer to 
print.

INFORMATION MENU

ITEM ACTION

MENU MAP Apply

PCL FONT Apply

PSE FONT Apply When PSE is installed

IBM PPR FONT Apply

EPSON FX FONT Apply
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Print menu

This menu provides adjustment of various print job related 
functions.

Media Menu

This menu provides adjustment to suit a wide range of print 
media.

DEMO 1 Apply

PRINT MENU

ITEM DEFAULT REMARKS

COPIES 1

MANUAL FEED OFF

PAPER FEED TRAY1

AUTO TRAY SWITCH OFF

ON

No optional tray installed

When Tray2 or MPF is 
installed

TRAY SEQUENCE DOWN

PAPER SIZE CHECK ENABLE

RESOLUTION 600 DPI

TONER SAVE MODE DISABLE

ORIENTATION PORTRAIT

LINES PER PAGE 64 LINES

EDIT SIZE CASSETTE 
SIZE

MEDIA MENU

ITEM DEFAULT REMARKS

TRAY1 PAPERSIZE A4

TRAY1 MEDIATYPE PLAIN

TRAY1 MEDIAWEIGHT MEDIUM

TRAY2 PAPERSIZE A4 When tray 2 is installed

TRAY2 MEDIATYPE PLAIN When tray 2 is installed

TRAY2 MEDIAWEIGHT MEDIUM When tray 2 is installed

MPF PAPERSIZE DL ENV When MPF is installed

MPF MEDIATYPE PLAIN When MPF is installed

MPF MEDIAWEIGHT MEDIUM When MPF is installed

 MANUAL PAPERSIZE A4

INFORMATION MENU

ITEM ACTION
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System configuration menu

This menu adjusts general printer settings to suit the way you 
prefer to work.

PCL emulation

This menu controls the printer’s PCL emulation.

MANUAL MEDIATYPE PLAIN

MANUAL MEDIAWEIGHT MEDIUM

UNIT OF MEASURE mm

X DIMENSION 210 mm

Y DIMENSION 297 mm

SYSTEM CONFIGURATION MENU

ITEM DEFAULT REMARKS

POWER SAVE DELAY TIME 10 MIN

EMULATION AUTO 
EMULATION

PARA PORT ASCII

USB PORT RAW

NW PORT RAW When NIC is installed

RS PORT ASCII When RS232 is installed

CLEARABLE WARNING ON

AUTO CONTINUE ON

MANUAL TIMEOUT 60 SEC

WAIT TIMEOUT 40 SEC

TONER LOW CONTINUE

JAM RECOVERY ON

ERROR REPORT OFF

LANGUAGE ENGLISH

PCL MENU

ITEM DEFAULT REMARKS

FONT SOURCE RESDENT

FONT No. I000

FONT PITCH 10.00 CPI

FONT HGT 12.00 Not displayed in default 
setup

SYMBOL SET PC-8

MEDIA MENU

ITEM DEFAULT REMARKS
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PPR Emulation

This menu controls the printer’s PPR emulation.

FX Emulation

This menu controls the printer’s FX emulation.

A4 PRINT WIDTH 78 COLUMN

WHITE PAGE SKIP OFF

CR FUNCTION CR

LF FUNCTION LF

PRINT MARGIN NORMAL

PEN WIDTH ADJUST ON

PPR MENU

ITEM DEFAULT REMARKS

CHARACTER PITCH 10 CPI

FONT CONDENSE 12 CPI to 
20 CPI

CHARACTER SET SET-2

SYMBOL SET IBM-437

LETTER O STYLE DISABLE

ZERO CHARACTER NORMAL

LINE PITCH 6 LPI

WHITE PAGE SKIP OFF

CR FUNCTION CR

LF FUNCTION LF

LINE LENGTH 80 COLUMN

FORM LENGTH 11.7 INCH 
(A4)

TOF POSITION 0.0 INCH

LEFT MARGIN 0.0 INCH

FIT TO LETTER DISABLE

TEXT HEIGHT SAME

FX MENU

ITEM DEFAULT REMARKS

CHARACTER PITCH 10 CPI

CHARACTER SET SET-2

SYMBOL SET IBM-437

PCL MENU

ITEM DEFAULT REMARKS
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Parallel menu

This menu controls the operation of the printer’s parallel data 
interface. 

RS232C menu

This menu controls the operation of the printer’s RS232C data 
interface.

LETTER O STYLE DISABLE

ZERO CHARACTER NORMAL

LINE PITCH 6 LPI

WHITE PAGE SKIP OFF

CR FUNCTION CR

LINE LENGTH 80 COLUMN

FORM LENGTH 11.7 INCH 
(A4)

TOF POSITION 0.0 INCH

LEFT MARGIN 0.0 INCH

FIT TO LETTER DISABLE

TEXT HEIGHT SAME

PARALLEL MENU 

ITEM DEFAULT REMARKS

PARALLEL ENABLE

BI-DIRECTION ENABLE

ECP ENABLE

ACK WIDTH NARROW

ACK/BUSY TIMING ACK IN BUSY

I-PRIME 3 MICRO SEC

OFF REC DISABLE Only when PSE is 
installed

RS232C MENU

ITEM DEFAULT REMARKS

RS232C ENABLE Only when RS232C is 
installed

FLOW CTL DTR HI Only when RS232C is 
installed

BAUD RATE 9600 Only when RS232C is 
installed

FX MENU

ITEM DEFAULT REMARKS
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USB menu

This menu controls the operation of the printer’s USB data 
interface.

Network menu

This menu controls the operation of the printer’s 10Base-T/
100Base-TX network interface.

DATA BITS 8 BITS Only when RS232C is 
installed

PARITY NONE Only when RS232C is 
installed

MIN. BUSY 200mSEC Only when RS232C is 
installed

OFF REC DISABLE Only when both RS232C 
and PSE are installed

USB MENU

ITEM DEFAULT REMARKS

USB ENABLE

SOFT RESET DISABLE

OFF REC DISABLE Only when PSE is 
installed

SERIAL NUMBER ENABLE

NETWORK MENU

ITEM DEFAULT REMARKS

TCP/IP ENABLE Only when NIC is installed

NETBEUI ENABLE Only when NIC is installed

NETWARE ENABLE Only when NIC is installed

ETHERTALK ENABLE Only when NIC is installed

FRAME TYPE AUTO Only when NIC is installed

IP ADDRESS SET AUTO Only when NIC is installed

IP ADDRESS Only when NIC is installed

SUBNET MASK Only when NIC is installed

GATEWAY ADDRESS Only when NIC is installed

INITIALIZE NIC? Only when NIC is installed

WEB/IPP ENABLE Only when NIC is installed

TELNET ENABLE Only when NIC is installed

FTP ENABLE Only when NIC is installed

RS232C MENU

ITEM DEFAULT REMARKS
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Memory menu

This menu determines how printer memory is used.

System adjustment menu

This menu provides fine adjustment of image position on the 
printed page in steps of 0.25mm.

Maintenance menu

This menu provides access to various printer maintenance 
functions.

SNMP ENABLE Only when NIC is installed

LAN NORMAL Only when NIC is installed

HUB LINK SETTING AUTO 
NEGOTIATE

Only when NIC is installed

MEMORY MENU

ITEM DEFAULT REMARKS

RECEIVE BUFF SIZE AUTO

RSRC SAV OFF

SYSTEM ADJUSTMENT MENU

ITEM DEFAULT REMARKS

X ADJUST 0.00 mm

Y ADJUST 0.00 mm

PCL MANUAL ID 2

PCL TRAY1 ID 1

PCL TRAY2 ID 5

PCL MP ID 6

PLACE PAGE CENTER

MAINTENANCE MENU

ITEM DEFAULT REMARKS

EEPROM RESET

DRUM COUNT RESET 

POWER SAVE ENABLE

SETTINGS 0

DARKNESS 0

NETWORK MENU

ITEM DEFAULT REMARKS
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Usage menu

This menu is for information only, and provides an indication of 
total usage of the printer and the expected life left in its 
consumable items. This is particularly useful if you do not have a 
full set of replacement consumables to hand and you need to 
know how soon you will need them.

PRINTING MENU SETTINGS

Current menu settings can be confirmed by printing a Menu Map.

1. Press the Menu button until the Information Menu is 
available.

2. Press the Item button until the display prompts you to 
print the menu map.

3. Press the Select button to print the menu map. 

CLEANING PAGE

MAINTENANCE MENU

ITEM DEFAULT REMARKS

USAGE MENU

ITEM DEFAULT REMARKS

DRUM LIFE REMAINING% An indication of how soon 
you will need to replace 
the drum.

TONER 6K=%   
2.5K=% 

An indication of how 
much toner is left in the 
cartridge.
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PAPER RECOMMENDATIONS
For guidance on the media you can use with your printer, which 
input tray and which ejection method to use, see the section 
entitled “Paper and tray information” in the “Specifications” 
chapter.

PAPER AND ENVELOPE TYPES

The manufacturer of this printer recommends the following 
guidelines when selecting paper and envelopes for use in your 
printer:

> Paper and envelopes should be stored flat and away from 
moisture, direct sunlight and heat sources.

> Use a smooth finished paper such as copier or laser type 
paper with a Sheffield (smoothness) rating of 250 or less. 
If in doubt, please ask your paper supplier.

> Use envelopes designed for use in laser type printers.

> The use of heavily laid or textured paper will seriously 
impact on the life of the image drum.

> Do not use very smooth, shiny/glossy paper.

> Do not use heavily embossed headed paper.

> Avoid printing on both sides and putting paper through 
the printer twice.

> Avoid using paper with perforations, cut-outs and ragged 
edges.

> Do not use envelopes with windows or metal clasps.

> Do not use envelopes with self sealing flaps.

> Avoid using damaged or curled envelopes.
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TRANSPARENCIES AND ADHESIVE LABELS

The manufacturer of this printer recommends the following 
guidelines when selecting transparencies and adhesive labels for 
use in your printer:

> Always manually feed single sheets using a Manual Feed 
Tray.

> Always use rear output.

> Media must be designed for use in laser printers or 
photocopiers and must be able to withstand 200°C for 0.1 
sec. 

> Do not use media designed for use in colour laser printers 
and photocopiers. 

> Labels should cover entire carrier sheet.

> Carrier sheet or adhesive must not be exposed to any part 
of the printer.
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INSTALLING PAPER

1. Remove the paper tray from the bottom of the printer and 
place plain paper in the tray, keeping the level of the 
paper in the tray below the guide arrowheads shown on 
the paper guides (1).

NOTE
If you are topping up the paper in a paper tray, it is 
recommended that you remove the remaining paper from the 
tray first then add the new paper stock followed by the paper 
you removed. This ensures that the oldest paper is used first 
to help prevent paper jams.

1

2

3 4
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2. Adjust the rear paper support (2) to the size of paper you 
are using by gripping the lugs (3), tilting and sliding the 
support forwards or backwards as necessary.

3. Adjust the paper guides (1). It is important to adjust the 
paper guides correctly to ensure that the paper is not 
skewed in the print process. Paper jams may occur if this 
operation is not carried out correctly.

4. Replace the tray in the printer. The paper level indicator 
(4) provides a visual indication of how much paper is left 
in the tray.

FACE UP AND FACE DOWN PRINTING

For face down printing, make sure the Rear Output Stacker is 
closed (the paper exits from the top of the printer). The Output 
Stacker on the top of the printer stacks printed pages face down, 
capacity 150 sheets of weight 80 g/m². Pages printed in reading 
order (page 1 first) will be sorted in reading order (last page on 
top, facing down).

For face up printing, make sure the face up Rear Output Stacker 
is open and the paper guide is extended if required. In this 
condition, paper will exit via this path, regardless of driver 
settings. Paper is stacked in reverse order, capacity 50 sheets of 
weight 80 g/m². 

Always use this tray in conjunction with the Manual Feed Tray for 
heavyweight stocks to reduce the possibility of paper jams. 

NOTE
Load letter headed paper face down and top edge towards the 
front of the paper tray.

NOTE
If you have the optional second paper tray (Tray 2) and you 
are printing from the first (upper) tray (Tray 1), you can pull 
out the second (lower) tray to reload it. However, if printing 
from the second (lower) tray, do not pull out the first (upper) 
tray as this will result in a paper jam.
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AUTOMATIC FEED SEQUENCE

With no optional feed trays installed, the Autotray function in the 
Print Menu is set by default to OFF and the Tray sequence 
function is set to DOWN. Ensure that the Autotray function is set 
to ON (default) when you have either or both optional feed trays 
installed. In this way, if a tray runs out of paper, automatic feed 
will take place in the order Tray 1, Tray 2 (if fitted), optional Multi 
Purpose Tray (if fitted), provided that these trays are set up for 
identical media. 

PRINTING ENVELOPES

1. Pull out the Rear Output Stacker (1) until it locks and lift 
out the paper guide (2). 

2. Pull down the Manual Feed Tray (3) and adjust the paper 
guides to the width of the envelope. 

3. Insert the envelope, flap down and to the left, until the 
printer grips it.

4. Set envelope size and landscape orientation in your 
software, then issue the print command.

1

2

3
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HEAVYWEIGHT PAPER OR CARDSTOCK

The normal paper path from a main paper tray to the top output 
stack involves two complete U-turns. This may sometimes cause 
very heavyweight paper or cardstock to jam or misfeed.

Use the Manual Feed Tray to feed this type of paper and the Rear 
Output Stacker to collect printed output. This gives a nearly 
straight paper path through the machine and may prove more 
reliable in this type of application.

PAPER FEED, SIZE AND MEDIA SETTING

The process used to fuse (fix) the printed image to the paper 
involves a mixture of pressure and heat. Too much heat will 
cause lightweight paper to crease or curl and corrugations in 
transparencies. Too little heat will cause the image not to fuse 
fully into heavyweight paper.

B4400, B4400L, B4400N, B4400LN

The print quality for different types of paper is adjusted by 
changing the media type as follows:

1. Start the Status Monitor.

2. Select the Printer Setup tab and click on the Printer 
Menu button. 

3. Select the Paper tab. Click on the button for the paper 
tray being used. Adjust the media type to the required 
setting and, if necessary, the paper size to the size of the 
paper being used.

4. Click on the Apply button, Close button then OK button 
to set the printer to the new media type and printing 
quality. 

NOTE
Although media properties can be set in the printer driver for 
particular jobs, when filling a tray with media it is 
recommended that you manually set the printer to match the 
media as described here.
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Printing transparencies

When printing transparencies, the Manual Feed Tray must be 
used and the media type changed to transparencies as follows:

1. Open the Manual Feed Tray on the printer and place the 
transparency face up between the paper guides.

2. Adjust the paper guides to the width of the transparency.

3. Start the Status Monitor.

4. Select the Printer Setup tab and click on the Printer 
Menu button.

5. Select the Paper tab and click on the Manual Feed 
button. Adjust the media type to Transparency and the 
paper size to the size of the transparency being used.

6. Click on the Apply button, Close button then OK button 
to set the printer for transparencies. 

B4600, B4600L, B4600N, B4600LN, B4600PS, B4600LPS, 
B4600NPS, B4600LNPS

Using the control panel on your printer, you can choose:

> which paper to use

> the size of the paper you wish to use

> the weight of the paper (thickness)

CAUTION!

Damage to the printer may occur if the incorrect 
setting is used when printing transparencies.

NOTE
Remember to reset the printer for normal paper after printing 
transparencies.
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> the type of paper

Paper feed selection

The paper feed, paper size, paper weight and media type can be 
set manually on the printer using the control panel as follows.

1. Press the Online button to return the printer to offline 
status.

2. Press the Menu button repeatedly until PRINT MENU is 
displayed, then press the Select button.

3. Press the Item button until the required paper feed is 
displayed.

4. Press the Select button. A plus (+) appears next to the 
selected paper feed.

NOTE
> If the settings in the printer differ from those selected on 

your computer, the printer will not print and the LCD will 
display an error message.

> The following printer settings are given as a guide only. 
Some software applications require the paper feed, size 
and media settings to be selected from within the 
application (page setup).

> Although media properties can be set in the printer driver 
for particular jobs, it is recommended that when filling a 
tray with media you manually set the printer to match 
the media as described here.

NOTE
When the AUTO TRAY SWITCH is set to ON and more than one 
paper tray is fitted, paper feed automatically switches to the 
next available paper tray, providing non-stop printing.
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Paper size

Set the paper size as follows.

1. Press the On Line button to return the printer to offline 
status.

2. Press the Menu button until PRINT MENU is displayed, 
then preset Select button.

3. Press either Item (+) or (-) button repeatedly until EDIT 
SIZE is displayed.

4. Press either Value (+) or (-) button until the required 
paper size is displayed, then press the Select button. A 
plus (+) appears next to the selected paper size.

5. Press the Online button to return the printer to ONLINE 
status.

6. Select the correct paper settings in the printer driver 
before printing the file.

Media type and weight

Set media type and weight as follows:

1. Press the Online button to return the printer to offline 
status.

2. Press the Menu button until MEDIA MENU is displayed, 
then press the Select button.

NOTE
> When using paper trays, standard paper sizes are 

recognised automatically with CASSETTE SIZE (default 
setting) selected. Paper size need only be set for custom 
paper sizes.

> When using the Manual Feed Tray, the paper size has to 
be selected.

CAUTION!

If media type or media weight are not correctly set, 
print quality deteriorates and the fuser roller may be 
damaged.
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3. Press the Item (+) or (-) button until MEDIA TYPE or 
MEDIA WEIGHT for the required tray is displayed.

4. Press the Value (+) or (-) button until the required paper 
type or weight is displayed, then press the Select button. 
A plus (+) appears next to the selected paper type or 
weight.

5. Press the Online button to return the printer back to 
online status.

Select the correct paper settings in the printer driver before 
printing the file.
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INTERFACES
Your printer is equipped with a selection of data interfaces:

1. Parallel – For direct connection to a PC. This port 
requires a bi-directional (IEEE 1284 compliant) parallel 
cable.

2. USB – For connection to a PC running Windows 98 or 
above (not Windows 95 upgraded to Windows 98) or 
Macintosh. This port requires a cable conforming to USB 
version 2.0 or above.

The operation of a printer is not assured if a USB 
compatible device is connected concurrently with other 
USB-compatible machines.

When connecting multiple printers of the same type, they 
appear as *****, ***** (2), ***** (3), etc. These 
numbers depend on the order of connecting or turning on 
each printer.

3. Serial – for direct connection to a device that uses serial 
printing (available as an option).

4. Ethernet – For network cable connection. This port is 
standard on the B4400n, B4400Ln, B4600n, B4600Ln and 
B4600nPS, B4600LnPS and optional on the B4400, 
B4400L, B4600, B4600L, B4600PS, B4600LPS.

If you are connecting your printer directly to a stand alone 
computer proceed to the chapter entitled “Printer Drivers”.

If your printer is to be installed as a network printer, please refer 
to the relevant section in the User’s Guide for the network 
interface card for further details on how to configure the network 
connection before installing the printer drivers.

NOTE
> It is not recommended that you connect serial/USB and 

parallel cables to the printer simultaneously.

> Interface cables are not supplied with your printer.

NOTE
Administrator’s authority is required when installing a 
network connection.



PRINTER DRIVERS
This chapter describes how to install a printer driver on two types 
of operating system – Windows and Macintosh.

The printer drivers are all contained on the printer driver CD-ROM 
(CD1). Please refer to the readme file on this CD for the latest 
information on printer driver installation.

WINDOWS OPERATING SYSTEMS

1. With Windows running, insert the printer driver CD-ROM 
(CD1) into your CD-ROM drive.

2. If the CD does not run automatically, use Start > Run... 
and enter E:\setup (where E is your CD-ROM drive) in the 
Open field.

3. Click on OK.

4. Select your printer model.

5. Click on Driver Installation > Install Printer Driver and 
follow the on-screen prompts to complete your printer 
driver installation.

6. For the B4400, B4400L, B4400n, B4400Ln only, once the 
driver has been installed, the Status Monitor is then 
automatically installed. 

7. For the B4600, B4600L, B4600n, B4600Ln, B4600PS, 
B4600LPS, B4600nPS, B4600LnPS, once the driver has 
been installed, the operator panel language switching 
utility will run automatically. Choose your preferred 
operating language.

NOTE
Take time to note the facilities available on the CD. For 
example, the Help facility briefly describes each of the 
Software Utilities.
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INSTALLED OPTIONS

Certain options may have been installed in your printer. For those 
that are installed, check that they appear enabled on the Menu 
Map (See “Confirming current settings” in “Operator panels”.) 

Ensure that your options are set up in the printer driver(s) by 
making the appropriate settings on the Device Options tab (PCL 
emulation) and/or Device Settings tab (PS emulation) described 
in the chapter entitled “Operation”.

MACINTOSH OPERATING SYSTEMS

Please refer to the readme file on CD1 for details on installing the 
appropriate Macintosh drivers.

INSTALLED OPTIONS

Ensure that any installed options are enabled in the printer 
driver.

CHOOSING A MAC DRIVER

The B4400, B4400L, B4400n, B4400Ln, B4600, B4600L, B4600n, 
B4600Ln models allow you to use a PCL Mac driver. 

The B4600PS, B4600LPS, B4600nPS, B4600LnPS models must 
always use a PS driver on Macintosh operating systems.
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OPERATION
This chapter provides a broad outline of how to operate your 
printer from either a Windows or a Macintosh environment. In the 
former, while PCL emulation is available on all printer models, PS 
emulation is standard only on the B4600nPS, B4600LnPS model 
and is optional on the B4600, B4600L and B4600n, B4600Ln 
models.

PRINTER SETTINGS IN WINDOWS

The operator panel controlled menus and Status Monitor 
controlled menus (described in the chapter entitled “Operator 
panels”) provide access to many options.

The Windows printer driver also contains settings for many of 
these items. Where items in the printer driver are the same as 
those in the operator panel and Status Monitor menus, and you 
print documents from Windows, the settings in the Windows 
printer driver will override those settings in the operator panel 
and Status Monitor menus.

PRINTING PREFERENCES IN WINDOWS APPLICATIONS

When you choose to print your document from a Windows 
application program a Print dialogue box appears. This dialogue 
usually specifies the name of the printer on which you will print 
your document. Next to the printer name is a Properties button.

When you click Properties a new window opens which contains 
a short list of the printer settings available in the driver, which 
you can choose for this document. The settings available from 
within your application are only those which you may want to 
change for specific applications or documents. Settings you 
change here will usually only last for as long as the particular 
application program is running.

NOTE
The illustrations in this guide relate to Windows 2000 PCL and 
PS emulations – other operating system windows may appear 
slightly different but the principles are the same.
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PCL EMULATION

The tabs available are the Setup Tab, the Job Options Tab and 
the Image Tab.

Setup Tab.

1. Paper size should be the same as the page size of your 
document (unless you wish to scale the printout to fit 
another size), and should also be the same as the size of 
paper you will feed into the printer.

2. You can choose the source of the paper to feed, which 
may be Tray 1 (the standard paper tray), Manual Feed 
Tray, Tray 2 (if you have the optional second paper tray 
installed) or the optional Multi Purpose feeder. You can 
also click on the appropriate part of the screen graphic to 
select your preferred tray.

If you select manual, the Weight selection box becomes 
visible. You can leave the setting at Printer Setting or 
select as required.

3. A variety of document finishing options can be selected, 
such as normal one page per sheet, or N-up (where N can 
be 2 or 4) for printing scaled down pages at more than 
one page per sheet.
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4. Under Manual 2-sided Printing, you can choose to print on 
one side of a sheet only or to use 2-sided printing (duplex 
printing). Your printer allows you to carry out manual 
duplex printing, meaning you must pass the paper 
through the printer twice. For more information, see “2-
sided printing (Windows only)” on page 69. The Duplex 
Help button also offers guidelines on how to carry out 
manual duplex printing.

5. If you have changed some printing preferences before and 
saved them as a set, you can recall them to avoid having 
to set them individually each time you need them.

6. A single on-screen button restores the default settings.

Job Options tab

1. The output resolution of the printed page can be set as 
follows.

> The ProQ1200 setting prints at 2400 x 600dpi. This 
setting requires the most printer memory and takes the 
longest to print. Your printed pages can be scaled to fit 
larger or smaller stationery. It is the best option for 
printing photographs.
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> The Fine/Detail setting prints at 1200 x 600dpi is the 
best option for printing vector objects such as graphics 
and text. 

> The Normal setting prints at 600 x 600dpi and is 
suitable for most printing jobs.

> The Draft setting prints at 300 x 300dpi and is suitable 
for printing draft documents that contain mainly text. 
You can select Toner Saving to save toner for some 
print jobs.

2. Page orientation can be set to either portrait (tall) or 
landscape (wide). Both views can be rotated by 180 
degrees. 

3. You can print watermark text behind the main page 
image. This is useful for marking documents as draft, 
confidential, etc.

If you would like to print on special stationery, such as 
forms and letterhead, but do not want to use pre-printed 
stationery, you can create your own using Overlays. For 
more information on “Overlays and Macros (Windows 
only)” on page 71. The Overlays button also offers 
guidelines on how to carry out manual duplex printing.

4. In Raster (bitmap) mode, processing of the page image is 
done in the computer leaving little processing for the 
printer to do, although the file size may be large. In 
Vector mode, file sizes may be smaller and so 
transmission over a network, for example, may be faster. 
These effects are more pronounced for graphics printing 
than for text printing.

5. You can select up to 999 copies to print consecutively, 
although you will need to top up the paper tray during 
such a long print run.

6. Your printed pages can be scaled to fit larger or smaller 
stationery, within a range of 25% to 400% of the original 
size.

7. A single on-screen button restores the default settings.
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Image tab

1. Dithering produces an intermediate greyscale by adjusting 
the combination of dots used in printing. Selecting a 
setting determines the degree of detail with which a 
graphics image will be printed. Mesh determines that a 
screen of dots is used for dithering while Line Art 
determines that an array of lines is used for dithering.

2. Select dithering texture by setting the size of dots used in 
the halftone screen.

3. Set this control to print greyscale effects in black without 
dithering. Select the check-box to disable greyscale 
printing or de-select the check-box to enable greyscale 
printing.

4. You can manually adjust lightness (the higher the setting 
the lighter the print) and contrast (the higher the setting 
the greater the contrast).

PS emulation

The tabs available are the Layout Tab, the Paper/Quality Tab 
and the Job Options Tab.
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Layout tab

1. Page orientation can be set to portrait (tall), landscape 
(wide) or landscape rotated by 180 degrees.

2. Printed page order can be set as front to back or back to 
front of the document.

3. Set the number of pages to be printed on a single sheet.
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4. Click the Advanced button to be able to set further 
document options as follows:

1. Select the required printed paper size.

2. You can substitute another font for TrueType Font.

3. You can set other document options as required, including 
PostScript options and printer features.

1

2

3

B4400, B4400L/B4600, B4600L User’s Guide – Operation > 60



Paper/Quality tab

You can set the paper source or leave it as automatic selection 
and by using the Advanced button you have access to the same 
set of options as described above for the Layout Tab.
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Job Options tab

1. The output resolution of the printed page can be set as 
follows.

> The ProQ1200 setting prints at 2400 x 600dpi. This 
setting requires the most printer memory and takes 
the longest to print. It is the best option for printing 
photographs. 

> The High Quality setting prints at 1200 x 600dpi and is 
the best option for printing vector objects such as 
graphics and text.

> The Normal setting prints at 600 x 600dpi and is 
suitable for most printing jobs. You can select Toner 
Saving to save toner for some print jobs

2. You can print watermark text behind the main page 
image. This is useful for marking documents as draft, 
confidential, etc.

If you would like to print on special stationery, such as 
forms and letterhead, but do not want to use pre-printed 
stationery, you can create your own using Overlays. For 
more information on “Overlays and Macros (Windows 
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only)” on page 71. The Overlays button also offers 
guidelines on how to carry out manual duplex printing.

3. You can select up to 999 copies to print consecutively, 
although you will need to top up the paper tray during 
such a long print run.

4. Your printed pages can be scaled to fit larger or smaller 
stationery.

5. Using the Advanced button gives you access to the 
facility to set mirror image printing or negative image 
printing.

6. A single on-screen button restores the default settings.

SETTING FROM WINDOWS CONTROL PANEL

When you open the driver properties window directly from 
Windows, rather than from within an application program, a 
somewhat more extensive range of settings is provided. Changes 
made here will generally affect all documents you print from 
Windows applications, and will be remembered from one 
Windows session to the next.

PCL emulation

The main tabs are the General Tab, Advanced Tab and Device 
Options Tab.
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General tab

1. This area lists some of the main features of your printer, 
including optional items.

2. This button opens the same windows as described earlier 
for items which can be set from within application 
programs. Changes you make here, however, will become 
the new default settings for all Windows applications.

3. This button prints a test page to ensure that your printer 
is working.

1

2 3

NOTE
The above features are provided by the Windows 2000 
operating system and will vary with other operating systems.
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Advanced tab

1. You can specify which times of day your printer will be 
available.

2. Indicates current priority, from 1 (lowest) to 99 (highest). 
Highest priority documents will print first.

3. Specifies that documents should be spooled (stored in a 
special print file) before being printed. The document is 
then printed in the background, allowing your application 
program to become available more quickly. Options 
follow:

This specifies that printing should not start until the last 
page has been spooled. If your application program needs 
a lot of time for further computation in the middle of 
printing, causing the print job to pause for more than a 
short period, the printer could prematurely assume that 
the document has finished. Selecting this option would 
prevent that situation, but printing will be completed a 
little later, as the start is delayed.

This is the opposite choice to the one above. Printing starts 
as soon as possible after the document begins spooling.
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4. This specifies that the document should not be spooled, 
but printed directly. Your application will not normally be 
ready for further use until the print job is complete. This 
requires less disk space on your computer, since there is 
no spool file.

5. Directs the spooler to check the document setup and 
match it to the printer setup before sending the document 
to print. If a mismatch is detected, the document is held 
in the print queue and does not print until the printer 
setup is changed and the document restarted from the 
print queue. Mismatched documents in the queue will not 
prevent correctly matched documents from printing.

6. Specifies that the spooler should favour documents which 
have completed spooling when deciding which document 
to print next, even if completed documents are lower 
priority than documents which are still spooling. If no 
documents have completed spooling, the spooler will 
favour larger spooling documents over shorter ones. Use 
this option if you want to maximise printer efficiency. 
When this option is disabled the spooler chooses 
documents based only on their priority settings.

7. Specifies that the spooler should not delete documents 
after they are completed. This allows documents to be re 
submitted to the printer from the spooler instead of 
printing again from the application program. If you use 
this option frequently it will require large amounts of disk 
space on your computer.

8. Specifies whether advanced features, such as pages per 
sheet, are available, depending on your printer. For 
normal printing keep this option enabled. If compatibility 
problems occur you can disable the feature. However, 
these advanced options may then not be available, even 
though the hardware might support them.

9. This button provides access to the same setup windows as 
when printing from applications. Changes made via the 
Windows Control Panel become the Windows default 
settings.

10. You can design and specify a separator page that prints 
between documents. This is particularly useful on a 
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shared printer to help each user find their own documents 
in the output stack.

Device Options tab

In this window you can select which optional upgrades are 
installed on your printer. See the chapter entitled “Installing 
options”.

PS emulation

The main tabs are the General Tab, Advanced Tab and Device 
Settings Tab. The General and Advanced tabs are the same as 
for PCL emulation described earlier.

NOTE
The above features are provided by the Windows 2000 
operating system and will vary with other operating systems.
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Device Settings tab

1. You can set the desired paper sizes in each of the 
available paper feed trays.

2. You can make a variety of font settings depending on your 
application.

3. You can set which optional upgrades are installed on your 
printer. See the chapter entitled “Installing options”.

PRINTER SETTINGS IN MACINTOSH

Refer to the readme file on the drivers CD, CD1, and the online 
help provided in the driver software.
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2-SIDED PRINTING (WINDOWS ONLY)
To carry out 2-sided, or Manual Duplex Printing you must pass 
paper through the printer twice. You can carry out 2-sided 
printing using the Paper Tray or the Manual Feed Tray. 

2-sided Printing is supported on Windows operating systems 
only. 

MANUAL DUPLEX PRINTING USING THE PAPER TRAY

1. Ensure that there is enough paper in the Paper Tray to 
carry out the print job. 

2. Select File -> Print and click the Preferences button. In 
the 2-sided printing drop down menu, select either “Long 
Edge” or “Short Edge” according to your printing 
preferences. If you require further information, click the 
Duplex Help button. Then, Click the Print button. 

3. Every second page of your document is printed first. 
When this is complete, a message appears on screen 
prompting you to take the paper, flip it and replace it in 
the Paper Tray. 
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4. Open the Paper Tray. 

5. Take the printed paper from the Output Stacker and place 
it in the Paper Tray, ensuring that the printed side is facing 
up and the bottom of the page facing into the printer. 

6. Close the Paper Tray and press the Online button. The 
message window should disappear from your screen and 
the document finishes printing the remaining pages of 
your document. 

MANUAL DUPLEX PRINTING USING THE MANUAL FEED TRAY

1. Position the paper guides on the Manual Feed Tray 
according to the paper size.

2. Place paper one sheet at a time in the Manual Feed Tray. 
The paper is automatically gripped in position.

3. Select File -> Print to display the Print dialog box.

4. Click the Preferences button. On the 2-sided printing 
drop down menu, select either “Long Edge” or “Short 
Edge” according to your printing preferences. If you 
require further information, click the Duplex Help button

5. When every second page has printed, take the paper from 
the output stacker.

6. Set the paper one page at a time in the Manual Feed Tray 
with the printed side facing down and the top of the page 
facing into the printer. Ensure that the paper is gripped in 
place.

7. Press the Online button. The remaining pages of your 
document print on the blank side of the paper, one sheet 
at a time as you feed it into the Manual Feed Tray.

NOTE:
When using the Manual Feed Tray, feed pages one sheet at a 
time. You can use either the standard Manual Feed Tray or 
the optional Multi Purpose Tray, providing that this is 
installed.
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OVERLAYS AND MACROS (WINDOWS ONLY)
WHAT ARE OVERLAYS AND MACROS?

If you would like to print on special stationery, such as forms and 
letterhead, but do not want to use pre-printed stationery, you 
can create your own using these advanced features.

You can use PostScript overlays to generate all your special 
stationery and store it in the printer for use whenever you need 
it. If you have chosen to install the PCL driver, macros perform a 
similar function.

You can create several overlays or macros, and combine them in 
any way you like to produce a variety of forms and other special 
stationery. Each image can be printed on just the first page of a 
document, on all pages, on alternate pages, or just the pages 
that you specify.

CREATING POSTSCRIPT OVERLAYS

Three steps are required to create an overlay:

1. Create the form data using your own application software 
and print it to a printer (.PRN) file.

2. Use the Storage Device Manager utility software supplied 
on CD with your printer to create a “project file,” import 
the.PRN file(s), and download the generated filter (.HST) 
file to the printer. The project file will contain one or more 
overlay images which are functionally related, such as the 
cover page and the continuation page images for business 
letters.

3. Use downloaded files to define your overlays ready for use 
when printing your documents.

When printing overlay files to disk, do not select any special 
features, such as two-sided printing or multiple copies. These are 
not appropriate to overlays, they apply only to your final 
documents.

NOTE:
PostScript overlays are not available for Windows 95/98/Me.
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CREATING THE OVERLAY IMAGE

1. Use your preferred application, perhaps a graphics 
program, to create the required overlay image and save 
it.

2. Open your 
application’s Print… 
dialogue.

3. Make sure that the 
selected printer 
name (1) is that of 
your PostScript 
printer driver.

4. Select the Print To 
File (2) option.

5. Click the Properties button (3) to open the Document 
Properties window.

6. On the Overlay tab, 
choose Create Form 
from the drop-down 
list (4).

7. Click OK to close the 
Document Properties 
window.

8. Click OK again to close 
the Print dialogue.

9. When prompted for a 
print file name, enter a meaningful name with the 
extension.PRN.

10. Close your application.
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CREATE AND DOWNLOAD THE PROJECT

1. From the Windows Start menu, start Storage Device 
Manager (SDM) and allow SDM to discover the printer.

2. Choose Printers→New Project.

3. Choose Printers→Add File to Project.

4. Set the Files of Type drop-down list to PRN 
Files(*.prn).

5. Navigate to the folder where the.PRN files are stored and 
select one or more of these to include in your overlay set.

You can have more than one printer (.PRN) file in a project. 
For example, one for top pages and another for 
continuation pages. Use standard Windows techniques 
(Shift or Ctrl keys) to select multiple files simultaneously if 
you need to.

6. Click Open to add these files to the current project.

7. When a message box appears confirming that a filter file 
has been created, click OK to clear the message.

8. The project window will display one.HST file for each 
printer file added. Make a careful note of each of these 
names. Ensure that you note them exactly as they appear, 
they are case sensitive, and you will need them later.

9. Choose Projects→Save Project and enter a meaningful 
name (e.g. “Letter Stationery”) so that you can recognise 
it later if you want to modify it.

10. Choose Projects→Send Project Files to Printer to 
download the project to the printer.

If you have a hard disk in the printer, SDM will 
automatically download files to it. If not, SDM will 
download files to flash memory. If you have a hard disk but 
still prefer to download to flash memory, double-click the 
file name in the Project window and under Volume, type 
in %Flash0% and then click OK.

11. When the message “Command Issued” appears 
confirming that the download is complete, click OK to 
clear the message.
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TEST PRINTING THE OVERLAY

1. Click on the printer icon for the relevant printer and 
choose Printers→Test Form.

2. In the Test PostScript Form window, to test each overlay 
select it and click OK. There will be a short pause while 
the printer processes the form, and then it will print.

3. When each overlay has been tested, click Exit.

4. Click the standard Windows Close (X) button, or choose 
Projects→Exit to close Storage Device Manager.

DEFINING OVERLAYS

This is the final step before the new overlays are ready for use.

1. Open the Printers (called “Printers and Faxes” in 
Windows XP) window via the Start menu or the Windows 
Control Panel.

2. Right-click on the Relevant PostScript printer icon and 
choose Printing Preferences from the pop-up menu.

3. On the Overlay tab, click the New button.

4. In the Define Overlays 
window, enter a suitable 
name (2) for this overlay and 
choose which page(s) (3) of 
your documents will use this 
overlay.

5. Enter the name of the overlay 
file (4) exactly as it appeared 
in the Storage Device Manager 
project window. Remember 
that this name is case 
sensitive.

If you forgot to note the overlay names when you created 
them, you can find them using Storage Device Manager to 
view the project file, or the printer’s Information Menu to 
print a file list and identify them from there.

6. Click Add (5) to add this overlay into the defined overlays 
list.

2
3

4
5
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7. Click OK to close the Define Overlay window.

The new overlay now appears in the Defined Overlays list 
in the printer properties window.

8. Repeat the above procedure if you wish to define more 
overlays.

9. When done, click OK to close the printer properties 
window.

Your new overlays are now ready and available to be used for any 
future documents you wish.

PRINTING WITH POSTSCRIPT OVERLAYS

Once you have defined your overlays you are ready to use them 
for any documents you wish. The example illustrated here uses 
two overlays for business letters. The first prints on just the top 
page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own 
application software. Remember, if necessary, to format 
the document so that it will fit within the appropriate 
space.

2. Open your application’s Print… dialogue and choose any 
options you will require, ensuring that the target printer is 
your PostScript printer driver in which the overlays have 
been defined.

3. Click the Properties button to open the Printing 
Preferences window.

4. On the Overlays tab, 
choose Use Overlay from 
the drop-down list (1).

5. Click on the first 
overlay (2) you wish to 
use. In this example it is 
the Cover Page overlay. 
Then click the Add 
button (3).

1

3
2

4
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6. If you want to use another overlay, in this case it is the 
Continuation page, click the second overlay (4) and then 
click the Add button (3) again.

7. When you have selected all the overlays you want to use 
for this document, click OK.

8. Finally, in your application’s print dialogue, click OK to 
begin printing.

CREATING PCL OVERLAYS

Three steps are required to create an overlay:

1. Create the form data using your own application software 
and print it to a printer (.PRN) file.

2. Use the Storage Device Manager utility software supplied 
on CD with your printer to create a “project file,” import 
the .PRN file, and download the generated filter (.BIN) 
files to the printer.

3. Use downloaded files to define your overlay ready for use 
with any future document.

When printing files to disk, do not select any special 
features, such as two-sided printing or multiple copies. 
These are not appropriate to macros, they apply only to 
your final documents.

CREATING THE OVERLAY IMAGE

1. Use your preferred application, perhaps a graphics 
program, to create the required image and save it.

2. Open your application’s 
Print… dialogue.

3. Make sure that the 
selected printer 
name (1) is that of your 
PCL printer driver.

4. Select the Print To 
File (2) option.

1 3

2
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5. When prompted for a print file name, enter a meaningful 
name with the extension .PRN .

6. Close your application.

CREATE AND DOWNLOAD MACROS

1. From the Windows Start menu, start Storage Device 
Manager (SDM) and allow SDM to discover the printer.

2. Choose Printers→New Project to start a new project.

3. Choose Printers→Filter Macro File. The Filter Printer 
Patterns dialogue box appears. Make any adjustments in 
the settings that you need and then click OK.

Example: If you create a black oval in MS Paint and leave 
all the colour command filters checked, the black oval will 
print as a black rectangle when the overlay is used. To 
maintain the oval shape, turn off (deselect) the “Configure 
Image Data,” “Palette ID” and “Palette Control” filters.

4. Set the Files of Type drop-down list to PRN 
Files(*.prn).

5. Navigate to the folder where the overlay .PRN files are 
stored and select one or more of these to include in your 
overlay set.

You can have more than one macro file in a project. For 
example, one for top pages and another for continuation 
pages. Use standard Windows techniques (Shift or Ctrl 
keys) to select multiple files simultaneously if you need to.

6. Click Open to add these files to the current project. (You 
can also drag and drop files from Windows Explorer 
directly into the project window if you prefer.) When a 
message box appears confirming that a filter file has been 
created, click OK to clear the message.

7. The project window will display one .BIN file for each 
printer file added. Make a careful note of the name and ID 
number for each of the files. You will need them later.

If you wish to edit the names or ID numbers, double-click 
the file entry and edit the details. 

Note that the names are case sensitive. 
B4400, B4400L/B4600, B4600L User’s Guide – 
Overlays and Macros (Windows only) > 77



8. Choose Projects→Save Project and enter a meaningful 
name (e.g. “Letter Stationery”) so that you can recognise 
it.

9. Choose Projects→Send Project Files to Printer to 
download the project to the printer.

10. When the message “Command Issued” appears 
confirming that the download is complete, click OK to 
clear the message.

TEST PRINTING THE MACRO

1. Choose Printers→Test Macro.

2. In the Test Macro window, enter its ID number and click 
OK. After a short pause the printer will print the macro.

3. When each macro has been tested, click Exit.

4. Click the standard Windows Close (X) button, or choose 
Projects→Exit to close Storage Device Manager.

DEFINING OVERLAYS

This is the final step before the new overlays are ready for use.

1. Open the Printers (called “Printers and Faxes” in 
Windows XP) window via the Start menu or the Windows 
Control Panel.

2. Right-click on the Relevant PostScript printer icon and 
choose Printing Preferences from the pop-up menu.

3. On the Job Options tab, click the Overlay button.

4. In the Overlay window, Click 
the Define Overlays 
button (1).

1
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5. In the Define Overlays window, 
enter the name (a) and ID (b) 
of the required overlay, and 
define which page(s) (c) of 
your documents will use this 
overlay. Then click the Add 
button (3) to add this overlay 
to the list of defined overlays. 
Repeat for any other related 
overlays. When done, click the 
Close button (4) to close the 
window.

The example illustrated shows two overlays defined, one 
for a cover page and one for continuation pages.

Remember that names and IDs of overlay files must be 
entered exactly as they appeared in the Storage Device 
Manager project window. Remember also that names are 
case sensitive.

If you forgot to note the overlay name or ID when you 
created them, you can find them using Storage Device 
Manager to view the project file, or the printer’s 
Information Menu to print a file list and identify them from 
there.

The new overlays will now appear in the Defined Overlays 
list in the printer properties window.

6. When done, click OK to close the printing preferences 
window.

Your new overlays are now ready and available to be used for any 
future documents you wish.

a

3

b

4

c
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PRINTING WITH PCL OVERLAYS

Once you have defined your overlays you are ready to use them 
for any documents you wish. The example illustrated here uses 
two overlays for business letters. The first prints on just the top 
page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own 
application software. Remember, if necessary, to format 
the document so that it will fit nicely within the plain areas 
on your letterhead overlay.

2. Open your application’s Print… dialogue and choose any 
options you will require, ensuring that the target printer is 
your PCL printer driver in which the overlays have been 
defined.

3. Click the Properties button to open the Printing 
Preferences window.

4. On the Overlay tab, check 
the Use active overlays 
checkbox (1).

5. In the Defined Overlays list, 
click on the first overlay (2) 
you wish to use, and click 
the Add button (3) to add it 
to the Active Overlays list. 
(If you want a reminder of 
how this overlay looks, click 
the Test Print button.)

6. If you want to use another overlay with this document, in 
this example it is the “Continuation Page” overlay, click 
this overlay (4) in the list of defined overlays, and then 
click the Add button (3) again to add the second overlay 
to the list of active overlays.

7. When the list of active overlays contains all the items you 
want to use, click OK.

8. Finally, click the Print button in your application’s Print 
dialogue to begin printing your document.

1

3

4

2
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CONSUMABLES AND MAINTENANCE
This section deals with the replacement of the toner cartridge and 
image drum and general maintenance.

CONSUMABLE ORDER DETAILS

*typical for continuous printing

Please always use genuine consumables. 

TONER CARTRIDGE LIFE

How long your toner cartridge lasts depends on the print density; 
the percentage of the page that prints black. A typical letter has 
3% to 5% print density; graphics usually have higher density. 
Higher print density means toner is used up faster. At 5% print 
density, a standard toner cartridge will print an average of 3,000 
pages. Remember, this is only an average: actual results may 
vary.

The first toner cartridge installed in a new printer has to fill the 
image drum reservoir and saturate the developing roller with 
toner. The first standard toner cartridge normally produces about 
1,000 pages after installation.

ITEM LIFE ORDER NO.

Toner, standard, B4400, B4400L, 
B4400n, B4400Ln, B4600, B4600L, 
B4600n, B4600Ln, B4600nPS, 
B4600LnPS, B4600PS, B4600LPS.

3,000 A4 @ 5% 43502302 (EU 
only) 

43502306 
(non-EU) 

Toner, high capacity, B4600, B4600L, 
B4600n, B4600Ln, B4600nPS, 
B4600LnPS, B4600PS, B4600LPS

7,000 A4 @ 5% 43502002 (EU 
only)

43502004 
(non-EU)

Image drum 25,000 A4 pages* 43501902
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WHEN TO REPLACE THE TONER CARTRIDGE

B4400, B4400L, B4400N, B4400LN

Replace the toner cartridge after Toner Low displays in the printer 
Status Monitor. Also, the Error LED indicator slowly blinks when 
toner is low. After Toner Low displays, the printer will print about 
100 more pages then display Toner Empty and stop printing. 
Printing will resume after a new toner cartridge has been 
installed.

B4600, B4600L, B4600N, B4600LN, B4600PS, B4600LPS, 
B4600NPS, B4600LNPS

When the toner is running low, TONER LOW is displayed in the 
operator panel LCD. If printing continues without replacing the 
toner cartridge, CHANGE TONER is displayed and printing is 
cancelled. Printing will resume after a new toner cartridge has 
been installed.

REPLACING THE TONER CARTRIDGE

It is recommended that you clean the LED array at the same time 
as you change the toner cartridge.

The toner used in this printer is a very fine dry powder contained 
in the toner cartridge.

Have a sheet of paper handy so that you have somewhere to 
place the used cartridge while you install the new one.

Dispose of the old cartridge responsibly, inside the pack that the 
new one came in. Follow any regulations, recommendations, etc., 
which may be in force concerning waste recycling.

If you do spill any toner powder, lightly brush it off. If this is not 
enough, use a cool, damp cloth to remove any residue. Do not 
use hot water, and never use solvents of any kind. They will make 
stains permanent.

WARNING!

If you inhale any toner or get it in your eyes, drink a 
little water or bathe your eyes liberally in cold water. 
Seek medical attention immediately.
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Switch off the printer and allow the fuser to cool for about 
10 minutes before opening the top cover.

1. Press the top cover release button and open the printer’s 
top cover fully.

2. Pull the coloured lever on the right side of the toner 
cartridge towards the front of the printer to close the 
cartridge then remove the used toner cartridge.

3. Gently wipe the LED array surface with a soft tissue.

4. Close the top cover and press it down to latch it closed.

IMAGE DRUM LIFE

The life of an image drum depends on a number of factors, 
including temperature and humidity, the type of paper used, and 
the number of pages per job.

The image drum should last approximately 25,000 pages 
continuous printing. This number is approximate because 
different numbers of pages are printed each time and the 
environmental conditions and the paper type used may vary.

WHEN TO REPLACE THE IMAGE DRUM

B4400, B4400L, B4400N, B4400LN

When the drum reaches 90% of its life, a CHANGE DRUM 
message is displayed in the printer Status Monitor. Also, the Error 
LED indicator blinks fast when the image drum requires 
changing. Change the image drum when the print becomes faint 
or begins to deteriorate.

WARNING!

If the printer has been powered on, the fuser may be 
hot. This area is clearly labelled. Do not touch.
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B4600, B4600L, B4600N, B4600LN, B4600PS, B4600LPS, 
B4600NPS, B4600LNPS

When the drum reaches 90% of its life, a CHANGE DRUM 
message is displayed in the operator panel LCD. Change the 
image drum when the print becomes faint or begins to 
deteriorate.

REPLACING THE IMAGE DRUM

It is recommended that you change the toner cartridge 
and clean the LED array at the same time as you change 
the image drum.

1. Press the cover release and open the printer’s top cover 
fully.

2. Remove the used image drum and toner cartridge.

3. Follow the installation instructions on or inside the box 
containing the new image drum to install the new image 
drum.

4. Follow the installation instructions on or inside the box 
containing the new toner cartridge to install the new toner 
cartridge.

CAUTION!

The green image drum surface at the base of the 
cartridge is very delicate and light sensitive. Do not 
touch it and do not expose it to normal room light for 
more than 5 minutes. If the drum unit needs to be out 
of the printer for longer than this, please wrap the 
cartridge inside a black plastic bag to keep it away 
from light. Never expose the drum to direct sunlight 
or very bright room lighting. Always hold the image 
drum unit by the ends or from the top.

WARNING!

If the printer has been powered on, the fuser may be 
hot. This area is clearly labelled. Do not touch.
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5. Gently wipe the LED array surface with the LED lens 
cleaner that came with the new toner cartridge or soft 
tissue.

6. Close the top cover and press it down to latch it closed.

RESETTING THE DRUM COUNTER

After replacing the image drum, reset the drum counter to keep 
a correct count of the number of pages printed on the image 
drum. 

B4400, B4400L, B4400N, B4400LN

1. Start the Status Monitor for the printer.

2. Select the Printer Setup tab, click on the Printer Menu 
button and then select the Maintenance Menu. 

3. Select “Reset Drum Count” and click on the Apply button 
to reset the drum counter. 

B4600, B4600L, B4600N, B4600LN, B4600PS, B4600LPS, 
B4600NPS, B4600LNPS

1. Press the Online button to return the printer to offline 
status.

2. Press the Menu button repeatedly until MAINTENANCE 
MENU is displayed, then press the Select button.

3. Press the Item button until DRUM COUNT RESET is 
displayed.

4. Press the Select button and the Drum Counter is reset.

5. Return the printer on line by pressing the Online button.
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GENERATING A CLEANING PAGE

If the printed page shows signs of fading, streaking or erratic 
marks, the problem may be cleared by generating a drum 
cleaning page as follows.

B4400, B4400L, B4400N, B4400LN

Using the printer Status Monitor

1. Start the Status Monitor for the printer.

2. Select the Printer Setup tab and click on the Printer 
Menu button. 

3. Select the Test Print tab and click on the Cleaning button.

4. Open the Manual Feed Tray and insert a sheet of A4 plain 
paper between the paper guides, then click the OK 
button. 

5. The printer grips the paper and prints a cleaning page.

6. If subsequent printing appears faded or uneven, try 
replacing the toner cartridge.

Using the Online button

1. Press the Online button to take the printer off line.

2. Open the Manual Feed Tray and insert a sheet of A4 plain 
paper between the paper guides. 

3. Press and hold down the Online button for at least five 
seconds.

4. The printer grips the paper and prints a cleaning page.

5. Return the printer on line by pressing the Online button.

6. If subsequent printing appears faded or uneven, try 
replacing the toner cartridge.
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B4600, B4600L, B4600N, B4600LN, B4600PS, B4600LPS, 
B4600NPS, B4600LNPS

1. Open the Manual Feed Tray and insert a sheet of A4 plain 
paper between the paper guides. To print from the Paper 
Tray, press the Online button when the LCD display 
prompts you to insert a sheet of paper in the Manual Feed 
Tray.

2. Press the Menu button repeatedly until MAINTENANCE 
MENU is displayed, then press the Select button.

3. Press the Item button until CLEANING PAGE is displayed.

4. Press the Select button.

5. The printer grips the paper and prints a cleaning page.

6. Press Cancel to exit the menu. The printer should now be 
on line. 

7. If subsequent printing appears faded or uneven, try 
replacing the toner cartridge.

CLEANING THE LED ARRAY

Clean the LED array whenever a new toner cartridge is installed 
or if there are faded vertical areas or light printing down a page.

Wipe the LED array gently with an anti-static cleaning pad that is 
generally available for computer cleaning.
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TROUBLESHOOTING

STATUS AND ERROR MESSAGES

Your printer has been designed to give you helpful status 
feedback not only during normal operation but also if a printing 
problem occurs so that you can take appropriate corrective 
action.

B4400, B4400L, B4400N, B4400LN

Both status and error messages are displayed in your chosen 
language in the Status Monitor, error messages being 
accompanied by the appropriate flashing of the Error indicator. 
You can set the Status Monitor to pop up on your computer 
screen when an alert condition occurs from the Preferences tab 
in the Status Monitor.

B4600, B4600L, B4600N, B4600LN, B4600PS, B4600LPS, 
B4600NPS, B4600LNPS

The LCD on the printer operator panel provides the self-
explanatory status and error messages in your chosen language. 
Error messages are accompanied by the Ready indicator being 
extinguished.

PAPER JAMS

Provided that you follow the recommendations in this guide on 
use of print media, and you keep the media in good condition 
prior to use, your printer should give years of reliable service. 
However, paper jams occasionally do occur, and this section 
explains how to clear them quickly and simply.

Jams can occur due to paper misfeeding from a paper tray or at 
any point on the paper path through the printer. When a jam 
occurs, the printer immediately stops, and the operator panel 
informs you of the event. If printing multiple pages (or copies), 
do not assume that having cleared an obvious sheet that others 
will not also be stopped somewhere along the path. These must 
also be removed in order to clear the jam fully and restore normal 
operation.
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The printer may experience a paper jam in one of three areas. 

> INPUT JAM - paper has failed to leave the selected feed 
tray and enter the internal paper path of the printer. A 
typical message indicates a paper jam and identifies the 
tray to check.

> FEED JAM - paper has entered the printer but failed to 
reach the exit. A typical message indicates a paper jam 
and advises you to open the top cover for access.

> EXIT JAM - paper has reached the exit but has failed to 
exit completely from the printer. A typical message 
indicates an exit jam and advises you to open the top 
cover for access.

INPUT JAM

1. Remove the paper tray from the printer.

2. Remove any crumpled or folded paper.

3. Remove any paper from the underside of the printer.

4. Replace the paper tray. 

After successful removal of any damaged or misfed paper, the 
printer should continue printing.

FEED JAM OR EXIT JAM

1. Remove the tray and clear any misfed sheets as given 
above.

2. Open the top cover.

WARNING!

The fuser area will be hot. This area is clearly marked. 
Do not touch it.
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3. Carefully lift out the image drum, complete with the toner 
cartridge. Be careful not to touch or scratch the green 
drum surface.

4. Remove any jammed sheets from the paper path.

5. Re-install the image drum complete with toner cartridge, 
ensuring that it correctly locates into the slots on each 
side of the printer.

6. Close the top cover and press down to latch it closed.

7. The printer will warm up and commence printing when 
ready. The page lost through the jam will normally be 
reprinted.

CAUTION!

Never expose the image drum unit to light for more 
than 5 minutes. Never expose the image drum unit to 
direct sunlight. Always hold the image drum unit by 
the ends or from the top. Never touch the surface of 
the green drum inside the image drum unit.

NOTE
If the edge of the jammed paper protrudes (or can be seen) 
from the exit, reinstall the image drum, close the top cover 
and switch the printer on. Remove the jammed paper from 
the exit when the exit roller begins rotating after a few 
seconds after switching on. However, if the jammed paper 
cannot be removed, contact a service representative.
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PRINT QUALITY PROBLEMS

Before consulting a service representative regarding a print 
quality problem, check the table below to see if there is a 
solution, or something you might have overlooked.

SYMPTOM PROBLEM SOLUTION

Blank sheets 
printed.

Image drum 
cartridge not 
properly installed.

Reinstall image drum cartridge.

Empty or missing 
toner cartridge.

Install new toner cartridge.

Entire page 
prints faintly.

Empty toner 
cartridge. Pages 
get fainter when 
toner is used up.

Install new toner cartridge.

LED array is dirty. Clean LED array.

Page has grey 
background.

Static electricity, 
generally from dry 
environments, 
causes toner to 
stick to 
background.

Change paper to a smoother laser 
bond or use a humidifier.

Page prints all 
black.

Hardware problem. Contact service.

Page has 
repetitive 
marks.

Damaged image 
drum cartridge 
causes repetitive 
marks every 1.6 
inches (4.06 cm) 
due to surface 
nicks and 
scratches.

Generate a cleaning page, 
repetitive marks may be 
temporary.

Oblong area of 
faint print 
appears on each 
page.

Drop out caused by 
using paper 
exposed to high 
humidity.

Change paper stocks, check paper 
storage environment or use a 
dehumidifier; check toner level.

Vertical white 
streaking or 
faint areas on 
page.

Toner is low and 
does not distribute 
properly, or the 
drum is worn out.

Replace toner cartridge. Check 
drum and replace the drum, if 
necessary. Contact service.

LED array is dirty. Clean LED array.

Vertical black 
lines.

Hardware problem. Contact service.
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Fuzzy print. LED array is dirty. Clean LED array.

Distorted print. Paper path, lamp 
assembly, or fusing 
unit problem.

Generate cleaning page.

Contact service.

Faded print. Toner cartridge is 
not correctly 
installed.

Toner low.

Install toner cartridge correctly.

Replace toner cartridge.

Smeared or 
blotched print.

Dirty rollers; toner 
dropped inside 
printer or image 
drum problem.

Replace image drum and toner.

Contact service.

Printed page is 
light/blurred.

Is toner low? Replace toner cartridge.

Is paper meant for 
laser printers?

Use recommended paper.

LED array is dirty. Clean LED array.

Bold characters 
and dark lines 
are smeared.

Toner is low. Install new toner cartridge.

Print is darker 
than usual.

Darkness setting is 
too high.

Change darkness setting.

Pages curl 
excessively.

Printing on wrong 
side of paper.

Turn paper over in tray. (Note 
arrow on paper package). Install 
paper print side down in tray.

Moisture in paper. 
Improper storage.

Avoid storing paper in areas of 
excessive temperature and 
humidity. Store paper in protective 
wrapping.

High humidity. Recommended operating humidity: 
20-80%

SYMPTOM PROBLEM SOLUTION
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SOFTWARE PROBLEMS

Your software (operating environment, applications and printer 
drivers) controls the printing process. Make sure you have 
selected the right driver for use with your printer. See your 
software documentation for more information.

HARDWARE PROBLEMS

SYMPTOM PROBLEM SOLUTION

Printing is 
garbled.

Incorrect driver is 
installed.

Install an appropriate driver.

Printer’s output 
is below rated 
speed.

Much of the 
printing delays will 
be caused by your 
application. 
Sometimes purely 
text documents will 
print slowly 
depending on the 
selected fonts and 
how they are 
transferred to the 
printer.

For maximum speed, use text in 
your document and use a printer 
resident font.

Size of top 
margin 
increases with 
each page 
printed.

Creeping text. 
Number of lines per 
page in software is 
not equal to 
number of lines per 
page of printer.

Many software packages assume 
66 lines per page, but your 
printer’s default is 64. Adjust 
software accordingly, or set LINES 
Per PAGE in the soft control panel 
to equal lines per page in your 
software.

SYMPTOM PROBLEM SOLUTION

Graphic image 
prints partly on 
one page, partly 
on the next.

Insufficient printer 
memory for this 
image at this 
resolution.

Change the resolution, reduce the 
image size, or install more memory 
in your printer.

When you try to 
print nothing 
happens, but 
printer indicates 
it is ready to 
receive data.

Configuration error. Check cable connection. If more 
than one printer is available, make 
sure your printer has been 
selected.

Garbage prints. Incorrect cable 
configuration. Also, 
see Software 
Problems.

Check cable configuration, 
continuity, and length.
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Printer freezes 
or displays error 
message when 
computer is 
rebooted.

Booting the 
computer while the 
printer is on can 
cause a 
communications 
error.

Turn printer off before rebooting 
computer.

Odours. Gases are given off 
by forms or 
adhesives passing 
through the hot 
fusing unit.

Make sure the forms you use can 
withstand heating, and provide 
adequate ventilation.

Printer is on but 
must warm up 
before a job is 
printed.

Power Save mode is 
set on to conserve 
energy. The fuser 
must heat up 
before you can 
begin printing the 
next job.

To eliminate warm up delay, change 
Power Save setting

SYMPTOM PROBLEM SOLUTION
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INSTALLING OPTIONS
The following options are available to extend the performance of 
your printer:

> 10/100 BASE-TX Network Interface Card: to make the 
B4400, B4400L and B4600, B4600L network compatible

> 16, 32, 64, 128, 256MB RAM DIMM: to extend the main 
memory of your printer and speed up the processing of 
large files

> RS232C Card: to provide serial interface capability for the 
B4400, B4400L and B4600, B4600L

> Second paper tray: to increase your printer’s paper 
handling capacity by 500 sheets (80g/m²)

> Multi Purpose Tray: to extend the range of media your 
printer can accommodate (capacity 100 sheets (80g/m²) 
or 50 envelopes)

> One of the following can be added:

(a) 8MB Flash DIMM: to allow the storage of additional 
fonts or bar codes for the B4400, B4400L, B4400n, 
B4400Ln, B4600, B4600L, B4600n, B4600Ln

(b) 16MB Flash DIMM: to allow the storage of additional 
fonts or bar codes for the B4400, B4400L, B4400n, 
B4400Ln, B4600, B4600L, B4600n, B4600Ln

(c) PostScript PS level 3 DIMM: to add PostScript 
emulation to the B4600, B4600L or B4600n, 
B4600Ln. Cannot be added in conjunction with extra 
flash memory. 

(d) The B4600, B4600L PS option is supplied as 2 
DIMMs: a PS DIMM and a 16MB RAM DIMM. When 
fitted into a basic B4600, B4600L or B4600n, 
B4600Ln (i.e. one with no memory upgrade already 
fitted) the PS DIMM will expand into the 16MB RAM 
DIMM in order to work, and the amount of memory 
available for general operation of the printer will 
therefore not change. It will remain at 16MB, which 
is the printer's base memory.
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(e) If you require to install a PS upgrade into a B4600, 
B4600L or B4600n, B4600Ln which already has a 
memory upgrade installed, discard the 16MB RAM 
DIMM which ships with the PS option and install only 
the PS DIMM. The result will be that the amount of 
overall memory available to the printer will decrease 
by 16MB as the PS code expands into 16MB of RAM 
currently installed. For example, a user who already 
has 128MB installed (total memory is therefore 
128+16=144MB) will fit only the PS DIMM and will 
then have 128MB of RAM left for printing.

INSTALLING OPTIONS ORDER NUMBERS

INSTALLATION PROCEDURE

To install any of the above options, follow the detailed installation 
sheet that accompanies the option.

10/100 BASE-TX Network Interface Card 
(NIC)

42264115

16MB RAM DIMM 42160903

32MB RAM DIMM 42160906

64MB RAM DIMM 42160913

128MB RAM DIMM 42160917

256MB RAM DIMM 42654503

RS232C 42264203

Second Paper Tray 40834412

Multi Purpose Tray 40109805

8MB Flash DIMM 42264005

16MB Flash DIMM 42264006

PostScript PS level 3 DIMM 42263919
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SPECIFICATIONS

GENERAL

A summary of the basic characteristics of your printer appears in 
the table below:

ITEM SPECIFICATION

Dimensions B4400, B4400L (N22105B): 
355mm x 395mm x 200mm (W x D x H)

B4600, B4600L (N22106B): 
355mm x 395mm x 215mm (W x D x H)

Weight 9 kg approximately

Printing 
method

Electro-photographic printing using LEDs as light source

Print colour Monochrome

Print speed B4400/B4600: 26 pages per minute maximum

B4400L/B4600L: 24 pages per minute maximum

Resolution 1200 x 600 dots per inch

Emulations PCL6, PCL5e, PCLXL, Epson FX, IBM ProPrinter, Mac OS9, Mac 
OS X for B4400, B4400L, B4400n, B4400Ln, B4600, B4600L, 
B4600n, B4600Ln

PCL6, PCL5e, Epson FX, IBM ProPrinter, Mac OS9, Mac OS X, 
PS for B4600PS, B4600LPS, B4600nPS, B4600LnPS

Interfaces Parallel port in compliance with IEEE 1284-1994 standard

USB 2.0 full speed

100BASE-TX/10Base-T for B4400n, B4400Ln, B4600n, 
B4600Ln, B4600nPS, B4600LnPS

Optional RS232C Serial interface 

Processor 200 MHz PowerPC

Memory 16 MB expandible to 272MB

Paper sizes A4, A5, A6, B5, Letter, Legal 13, Legal 14, Executive, Custom, 
Envelopes (5 types)

Paper feed Automatic feeding via paper trays (including optional tray and 
optional Multi Purpose Tray)

Manual feeding of single sheets
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Paper feed 
capacity
at 80g/m²

Tray 1: 250 sheets 

Optional Tray 2: 500 sheets

Optional Multi-purpose feeder: 100 sheets

Paper output Face up, face down depending on paper size, type and 
thickness

Power 
consumption

Typical: 400W

Idle: 70W

Power save mode: 7-10W

Paper output 
capacity at 
80g/m²

Face up: 50 sheets

Face down: 150 sheets

Monthly duty 
cycle

3,000 pages

Consumables Toner cartridge, Image drum

Power cable Approximately 1.8 m max. length (not provided)

Noise level Operation: 53 dB(A) 

Standby mode: 30dB(A)

Power saving mode: Background level

Environmental 
conditions

Operation: 10 - 32°C, 20% - 80% RH, 

Storage: 14 - 110°C, 10% - 90% RH

When the printer is stored, it should be in its original 
packaging, with no moisture formation.

ITEM SPECIFICATION
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PAPER AND TRAY INFORMATION

Feed and ejection methods vary depending on the type, size and 
thickness of medium used. Use the chart below and the notes/
symbols/terms on the following page for initial guidance. (Minor 
variations to settings may be necessary depending on user setup 
and environmental conditions.) 

FEED
CASSETTE

EJECTION 
METHOD

PAPER 
TYPE

SIZE WEIGHT T1 T2 MPF MF FU FD

Plain 
paper

A4

A5

B5

Letter

Executive

L, ML, M o o o o o o

MH, H x x o o o x

Legal 
(13)

Legal 
(14)

L, ML, M o o x o o o

MH, H x x x o o x

A6 L, ML, M o x o o o x

MH, H x x o o o x

Custom

W: 90 – 
216

L: 148 – 
356

L, ML, M o o o o o o

MH, H x x o o o x

Env-
elopes

Com-9

Com-10

DL

C5

Monarch

Custom

W: 90 – 
216

L: 148 – 
356

– x x o o o x

Labels A4

Letter

– x x o o o x

Transp-
arencies

A4

Letter

– x x o o o x
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NOTES/SYMBOLS/TERMS

Notes:

1. When an optional second paper tray is used, the original 
tray is referred to as Tray 1 and the optional tray as Tray 
2.

2. It is not possible to use custom paper sizes with the PS 
emulation driver.

3. Tray 2 can accommodate paper with width of 148 to 
216mm and length of 210 to 316mm.

4. Paper smaller than A5 (i.e. less than 210mm long) should 
be ejected face up. 

SYMBOL/
TERM

MEANING

T1 Paper Tray 1

T2 Paper Tray 2 (optional)

MPF Multi Purpose Tray (optional)

MF Manual Feed Tray

FU Face Up printing from the rear of the printer

FD Face Down printing from the top of the printer

W, L Width, Length in mm

L Light paper weight: 59 - 66g/m²

ML Medium Light paper weight: 67 - 73g/m²

M Medium paper weight: 74 - 88g/m²

MH Medium Heavy paper weight: 89 - 104g/m²

H Heavy paper weight: 105 - 122g/m²

o Can be used

x Cannot be used
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Parallel menu ..................... 27, 37
PCL menu .......................... 26, 35
PPR menu .......................... 26, 36
Print menu......................... 24, 34
RS232C menu .................... 28, 37
System adjustment menu .... 29, 39
System configuration 

menu .............................. 25, 35
Usage menu....................... 30, 40
USB menu ......................... 28, 38
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OKI CONTACT DETAILS
Oki Systems (UK) Limited
550 Dundee Road
Slough Trading Estate
Slough, SL1 4LE

Tel:44 (0) 1753 819819
Fax:44 (0) 1753 819899
http://www.oki.co.uk

Oki Systems Ireland Limited
The Square Industrial Complex
Tallaght, Dublin 24, Ireland

Tel:+353 1 4049590
Fax:+353 1 4049591
http://www.oki.ie

OKI Systems (Ireland) Ltd.
40 Sydenham Park
Belfast, BT4 1PW

Tel:+44 44 (0)28 90 20 1110
http://www.oki.ie

Technical Support for all of Ireland:
Tel: +353 1 4049570
Fax: +353 1 4049555
E-mail: tech.support@oki.ie

Oki Data Corporation
4-11-22 Shibaura, Minato-ku, Tokyo 
108-8551, Japan

Tel: (81) 3 5445 6158
Fax: (81) 3 5445 6189
http://www.okidata.co.jp

Oki Data (Singapore) Pte. Ltd.
78 Shenton Way, #09-01,
Singapore 079120

Tel: (65) 221 3722
Fax: (65)421 1688
http://www.okidata.com.sg

Oki Systems (Thailand) Ltd.
956 Udomvidhya Building 6th Floor, 
Rama IV Rd., Bangkok 10500, Thailand

Tel: (662) 636 2535
Fax: (662) 636 2536
http://www.okisysthai.com

Oki Hong Kong Limited
Suite 1909, Tower3,
China Hong Kong City,
33 Canton Rd., Tsimshatsui,
Kowloon, Hong Kong

Tel: (852) 2736 0130
Fax: (852) 2376 3725

The IPL Group
63-85 Victoria Street
Beaconsfield NSW 2015, Australia

Tel: (61) 2 9690 8200
Fax: (61) 2 9690 8300
http://www.oki.com.au

Comworth Systems Ltd.
10 Constellation Drive Mairangi Bay, 
Auckland,
New Zealand

Tel: (64) 9 477 0500
Fax: (64) 9 477 0549
http://www.comworth.co.nz
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Oki Europe Limited

Blays House

Wick Road

Egham, Surrey TW20 0HJ

United Kingdom

Tel: +44 (0) 208 219 2190
Fax: +44 (0) 208 219 2199
www.okiprintingsolutions.com

07083001 iss.3


	Preface
	Emergency First Aid
	Importer to the EU
	Environmental information

	Introduction
	Printer features
	Using your printer

	About this manual
	Online usage
	Printing Pages
	Abbreviations used

	Printer components
	Operator panels
	B4400, B4400L, B4400n, B4400Ln
	Operator panel
	LED indicators
	Online button
	Status Monitor
	Menu functions
	Printing menu settings

	B4600, B4600L, B4600n, B4600Ln, B4600PS, B4600LPS, B4600nPS, B4600LnPS
	Operator panel
	Panel elements
	Menu functions
	Printing menu settings


	Paper recommendations
	Paper and envelope types
	Transparencies and adhesive labels
	Installing paper
	Face up and face down printing
	Automatic feed sequence
	Printing envelopes
	Heavyweight paper or cardstock
	Paper feed, size and media setting
	B4400, B4400L, B4400n, B4400Ln
	B4600, B4600L, B4600n, B4600Ln, B4600PS, B4600LPS, B4600nPS, B4600LnPS


	Interfaces
	Printer drivers
	Windows operating systems
	Installed options

	Macintosh operating systems
	Installed options
	Choosing a Mac driver


	Operation
	Printer settings in Windows
	Printing preferences in Windows applications
	PCL emulation
	Setting from Windows Control Panel

	Printer settings in Macintosh

	2-sided printing (Windows only)
	Manual duplex printing using the paper tray
	Manual duplex printing using the Manual Feed Tray

	Overlays and Macros (Windows only)
	What are overlays and macros?
	Creating PostScript overlays
	Creating the overlay image
	Create and download the project
	Test printing the overlay
	Defining overlays

	Printing with PostScript overlays
	Creating PCL Overlays
	Creating the overlay image
	Create and download macros
	Test printing the macro
	Defining overlays

	Printing with PCL overlays

	Consumables and maintenance
	Consumable order details
	Toner cartridge life
	When to replace the toner cartridge
	B4400, B4400L, B4400n, B4400Ln
	B4600, B4600L, B4600n, B4600Ln, B4600PS, B4600LPS, B4600nPS, B4600LnPS

	Replacing the toner cartridge
	Image drum life
	When to replace the image drum
	B4400, B4400L, B4400n, B4400Ln
	B4600, B4600L, B4600n, B4600Ln, B4600PS, B4600LPS, B4600nPS, B4600LnPS

	Replacing the image drum
	Resetting the drum counter
	B4400, B4400L, B4400n, B4400Ln
	B4600, B4600L, B4600n, B4600Ln, B4600PS, B4600LPS, B4600nPS, B4600LnPS

	Generating a cleaning page
	B4400, B4400L, B4400n, B4400Ln
	B4600, B4600L, B4600n, B4600Ln, B4600PS, B4600LPS, B4600nPS, B4600LnPS

	Cleaning the LED array

	Troubleshooting
	Status and error messages
	B4400, B4400L, B4400n, B4400Ln
	B4600, B4600L, B4600n, B4600Ln, B4600PS, B4600LPS, B4600nPS, B4600LnPS

	Paper Jams
	Input jam
	Feed jam or exit jam
	Print quality problems
	Software problems
	Hardware problems

	Installing options
	Installing options order numbers
	Installation procedure

	Specifications
	General
	Paper and tray information
	Notes/symbols/terms


	Index
	Oki contact details


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


